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Introducing Bartco VMS Web Studio® 

BARTCO VMS WEB STUDIO® is a web-based application that runs on BARTCO's secure cloud network 
for maximum security and high availability. It has been developed to allow customers to interact and 
provide full management of their BARTCO products, including Variable Message Signs (VMS), 
Variable Speed Limit Signs (VSLS), Electronic Fire Danger Rating signs, Electronic Snow / Wheel Chain 
Rating signs and Portable Traffic Signals, etc. 
 
VMS WEB STUDIO® is a real-time internet-based communication facility enabling live communication 
via cellular or satellite networks from any internet enabled PC, laptop, tablet or mobile, eliminating 
the need for the installation of local software. 
 
Features include: 

• Fully web based allowing remote programming from any internet enabled PC / Laptop / 
Tablet or mobile. 

• Secure login 

• Asset Management and tracking system 

• Create and manage customers (perfect for hire/rental companies) 

• Quick and easy operation 

• Clean user-friendly interface 

• Asset grouping 

• Program multiple assets instantly 
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1. Logging In 

From the browser address bar go to the VMS Web Studio web page: www.vmsstudio.com 

 
Enter your username and password as received in your email.  
 
Notes: 

- If you have not been allocated a username and password, please contact Bartco to receive a 
user access form. 

- Contact Bartco to delete a user from Web Studio 
- Bartco suggests using Google Chrome as the best compatible browser with Web Studio. 

Google Chrome can be downloaded at the link: http://www.google.com/chrome 

 

 
  
 

  

http://www.vmsstudio.com/
http://www.google.com/chrome
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2. Web Studio Main Page Orientation 

 
 
 
 
 
 

 
 

 

 

 

 

 

 
  

Details on asset’s status 
like battery, active file, 

luminance, etc. 

Information panel: 
displays result of an 

action on asset 

Real time 
asset’s location 

on map 

Feature / Tool tabs: 
Each tab represents a 

different operational feature 

Asset list: List of all 
assets that user 
has access to.  

 

Dashboard 
provides helpful 

insights on assets 
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3. Assets, Groups and Job Queue 

 

3.1 Assets 

All the assets are displayed in the Assets List. 
 
 
 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 

Filter assets by name, 
type, group, etc. 

Search asset by 
name, serial number, 

etc. 

Asset icon: type 
of the asset 

Status icons: 
legends described 

below 
 

Asset name 

User defined 
Group name 

 

Select all assets, select 
none, invert selection 

Total number 
of assets in list 

Number of 
selected assets 

Various filters 
applied to assets 
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3.1.1 Asset’s icon and status icons 

Asset’s icon represents type of the asset: 
 

 
5 Colour A Size 

 
Amber A Size 

 
5 Colour B Size 

 
Amber B Size 

 
5 Colour C Size 

 
 

Amber C Size 

 
Portable Traffic Light - Master 

 
Fire Sign 4 Ratings 

 
Portable Traffic Light – Slave 

 
 

Retrofitted Fire Sign 

 
VSLS (Variable Speed Limit Sign) 

  
HDA sign               

 
Half Size - Speed Sign 

 
HDC sign 

  
 

Wide Size Sign 

 
 
Asset shows several status icons to denote various state of an asset as described below: 

 
 

 Status older than 24 hours 

 Asset has communicated in last 24 hour and has warning 

 Asset has communicated in last 24 hour 
 

 Battery Low (warning) 

 Battery OK 

 Battery Good 
 

 Low signal strength (warning) 

 Weak signal strength 

 Strong signal strength 
 

 Locked by Web Studio 

 Automatic programming enabled 

 Automatic programming disabled 
 

 Firmware critically out of date (warning) 

 Latest firmware installed 
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 Radar enabled 

 Radar disabled 
 

 Locked by Road Authority 

 Not locked by Road Authority 
 

 Satellite enabled 

 Satellite disabled 
 

 Asset is currently on hire to HIRE-CUSTOMER-NAME 

 Asset is hired to HIRE-CUSTOMER-NAME and hire duration is inactive 

 Asset is available to hire 

 No permission to hire asset 
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3.1.2 Filters 

Filter assets by Alert, Controller Config, asset type, etc. 
 
Assets by Alert menu shows below alerts: 
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Controller Config menu shows below options: 

 
 
 
 
Various filters can be applied simultaneously to the assets list. 

For example, filter all assets that are currently on hire   and has low battery : 
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3.1.3 Quick options menu 

Right click on selected asset in the Assets list to display quick options menu. 
Note: this menu changes based on asset’s type. 
 
The following is an example of quick options menu on VMS: 
 

 
 

 
i. Update status 

Manually update the status of asset 
 

ii. Blank sign 
Blank the display of asset 
 

iii. Wake sign 
Start displaying last message on the asset 
 

iv. Sleep sign 
Put asset in sleep mode 
 

v. Program History 
Show history of messages programmed on the asset 
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3.2 Groups 

Very useful if you have multiple assets in your account. Assets can be grouped by one project, area, 
or section of roadway using user defined group name. 
 

 
 
 
Selecting a group will list all the assets in that group: 
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➢ Group an asset using Asset Info: 

i. Select asset from Assets list 
 

ii. Go to Asset Info 
 

iii. Update value of the “Group” field 
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➢ Group an asset using Groups/Filter: 

i. Select asset from Assets list 

ii. Select  

 
 

iii. Select “Move to” or “Move to new Group” option from Selected Assets menu 
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3.3 Job Queue 

Upload file, updating status, etc. tasks are added in the Job Queue. When the job is completed 
successfully, it will be removed from the Job Queue. If there is an error in completing the job, then 
the error is displayed in the Job Queue. 
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4. Asset Information 

Click on an asset to see its detailed status. 
 

4.1 Asset Status 

The fields in the status changes based on the asset type. The below is an example of VMS: 
 

 
 

Date Last date when asset communicated with Web Studio 

Time Last time when asset communicated with Web Studio 

Firmware version Firmware version of the asset 

Serial number Serial number of the asset 

Active File Asset is currently displaying this file 

Active Status State of the asset 

Asset’s status 
 

Active File: Displays 
the real time 

status/message of 
the selected asset. 



 

 

Phone: 1300 306 106  
Email:  service@bartco.com.au    Page 16 of 52 

VMS WEB STUDIO® User Manual v4.1.0 

Battery voltage Battery of the asset 

Temperature Temperature of the controller in centigrade 

Cooling Fans Cooling fans are active or inactive 

LED Output Brightness of the display in percentage 

Luminance Shows level of luminance and Auto or Manual mode 

Trip Wire Tamper Alarm loop 
The name of this field can be set using “Input 1 Label” in Asset Info. 
Default value is “Trip Wire” 

Radar Radar is enabled/disabled on the asset 

GPS Lat GPS latitude of the asset 

GPS Long GPS longitude of the asset 

Global ON:OFF Time Global time to switch the display on/off 

Signal Strength Signal strength of the asset 

Files List of files stored on the asset 
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4.2 Asset Info 

  
 

Company Owner company of the asset 

Asset ID Unique identified of the asset 

Model / Plant type Asset type 

Label Name of the asset (editable by user) 

Client Ref Another name of the asset (editable by user) 

Group Group of the asset (editable by user) 

Trailer VIN VIN number of the asset’s trailer 

Trailer Registration Rego number of the asset’s trailer 

Trailer Serial Serial number of the asset’s trailer 

Serial number Serial number of the asset 

Hardware Version Hardware version of the asset 

Firmware Version Firmware version of the asset 

Input 1 Label Label for Input 1 on the controller (editable by user) 

Radar Fitted Radar is fitted on the asset (editable by user) 

Special Features Any special characteristics of the asset, such as 4G 

Trailer Key Trailer key of the asset (editable by user) 

SIM PIN Sim card PIN number (if applicable) 

Value of these 
fields can be 

edited by the user 
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5. Update Status 

To update the status of an asset: 
 

i. Select asset(s) from the Assets list 
 

ii. Right click on selected asset(s) 

 
 

iii. The user will be prompted as follows: 

 
  

iv. Click on OK to update status of the selected asset(s). The job will appear in Job Queue. 
Click on Cancel button to cancel uploading. 

 
 

On completion, the result will be displayed in the Information panel at the bottom of the 
page. 
 
Success:        Failed: 
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6. Mapping 

Bartco’s assets have inbuilt tracking system. This is used to display location of assets on maps. 
The location of the asset is the last known location of asset when it communicated with Web Studio. 

 

 

 

 
 
 

  

Double click on asset to 
get a close-up of the 

asset location 

Get directions to 
your asset from a 

given address 

Print map 
view 

Measure distance 
between points 
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7. Create Message 

Creating a message is undertaken by selecting the “New File” tab from the main navigation page. 
This tab is also known as Drawing Area which creates Standard file. Once the message is prepared 
and saved under a name then that name will appear on the tab instead of new file/untitled. 
 

 

 

 

 

 

 
 

 

 

 

 

 

Draw or type your desired message in the drawing area. The drawing area is scaled to be the same 
size as the asset (VMS, Fire sign, etc.).  
 
The message can be typed in colour by selecting the required colour from the Drawing Tools. 

Different font sizes and line alignments are also available to choose. 

 

Multiple frames can be created. 
Use paging buttons to navigate 

between frames 

Drawing area: type text or draw design 

This is visual representation of your 
asset’s display (VMS, Fire sign, etc.) 

Predefined images can 
be used directly on 

drawing area 

Upload 
standard 

file to asset 

Drawing tools like 
pen, eraser, colours, 

flashing, font size, etc. 
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Various functions on the frame can be performed using the below menu: 
 

 
 

 

 

 

 

 

 

Multiple frames can be created with different frame time. Use paging button to navigates through 
the frames. 

 
 

Frame timing can start at 0.1 of a second to create animations. Length of message, asset position 
and target audience should all be considered when selecting frame times. 
 
 
 

7.1 Predefined Images 

Several predefined images are available like speeds, land closure, etc. which can be loaded directly 
onto the frame to prepare a message. 
 

➢ To load a predefined image: 

i. Select image from the predefined images list 
 

ii. Click on “Load >>” button 
Predefined image will be loaded in frame on the drawing area 

 

 
 

Preview 
of the 

file 

Manage 
frames and 

apply 
transitions 

Load image 
or save 

frame as an 
image 

Cut, copy, 
paste, etc. 
on frames 

Step i 

Apply or 
clear flashing 

on frame 

Invert 
colours 

on frame 

Step ii 

Apply 
setting to 
all frames 
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7.2 Message Transitions/Animations 

More commonly VMS are being used for advertising and promotions. Web Studio has the ability to 
create dynamic and animated messages to enhance the appeal of your message. 
 
To create a message transition or animation, simply create your message and then click on the 
Frame Organizer button from the menu. 
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➢ To apply transition/animation to your message: 

i. Click on desired frame to be animated in Frame Organizer 
 

ii. Select transition/animation from the dropdown 

 
 

iii. Select side 

 
 

iv. Set frames per second 
Note: higher the frame per second, lower the speed of the animation and more the number 
of frames in transition.  

 
v. Click on Apply button 

The selected frame will display the preview of the transition 
 

 

 
 

vi. After finishing applying transitions to desired frames, click on OK to save the changes and 
close the Frame Organizer 
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7.3 Preview 

Check the preview of the message to see how it will look on the VMS: 
 

 
 
Preview of the message: 
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8. Uploading file to asset 

Once the file has been prepared, it can either be saved or directly uploaded to the asset. To use 
messages in Radar and/or Schedule, it needs to be saved first. The message is saved in the cloud and 
is accessible to all the users of your company using their Web Studio account. 
 
 

8.1 Save File 

 
i. Go to File -> Save As 

 
 

ii. Enter filename and click on Save As button to save the file 
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8.2 Open File 

i. Go to File -> Open 

 
 

ii. Select file from the list and click on Open button 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

Phone: 1300 306 106  
Email:  service@bartco.com.au    Page 27 of 52 

VMS WEB STUDIO® User Manual v4.1.0 

8.3 Upload saved file to asset 

i. After your file has been saved/opened, select asset(s) from the Asset list that you wish to 
upload the message to. 
Note: Multiple assets can be programmed simultaneously by holding down the shift or Ctrl 
key on your keyboard when selecting asset(s).  
 

ii. Click on Upload button   
The file that is open in the tab will be uploaded to the selected asset. 

 
 
 
 

iii. The user will be prompted as follows: 

 
 

iv. Click on YES to upload file to the selected asset(s). The job will appear in Job Queue. 
Click on NO to cancel uploading. 

 
 

On completion, the result will be displayed in the Information panel at the bottom of the 
page. 

 

Success:         Failed:  

    
 

Note: After you have uploaded your message, the active file will update with your current 
message and the overall asset status. 
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8.4 Upload file without saving 

Messages can be uploaded without saving them first.  
 

i. After your desired message is prepared, select asset from the Asset list that you wish to 
upload the message to. 
Note: Multiple assets can be programmed simultaneously by holding down the shift or Ctrl 
key on your keyboard when selecting asset(s).  
 

ii. Click on Upload button  
The message will be automatically saved into your __Unsaved_Files folder. 
Notes: 

- Files in this folder can be opened and resaved into another folder. 
- Files cannot be manually saved into this folder. 
- Files cannot be moved in or out of this folder with the File Manager. 

 
iii. The user will be prompted as follows to remind that an unsaved file is being uploaded: 

 

 
 

iv. Click on YES to upload file to the selected asset(s). The job will appear in Job Queue. 
Click on NO to cancel uploading. 

 
 

On completion, the result will be displayed in the Information panel at the bottom of the 
page. 

 

Success:         Failed:  

    
 

Note: After you have uploaded your message, the active file will update with your current 
message and the overall asset status. 
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9. Quick Speed 

Quick speed is designed to quickly change speed limits on VMS or VSLS assets. 
 

➢ To change the speed: 

i. Select speed from the dropdown list 
 

ii. Select asset(s) from the Assets list 
 

iii. Click on “Upload” on Quick Speed tab 
 

 
 

iv. The user will be prompted as follows: 

 

 
  

v. Click on OK to upload speed to the selected asset(s). The job will appear in Job Queue. 
Click on Cancel button to cancel uploading. 
 

 

Step i 

Step iii 

Step ii 



 

 

Phone: 1300 306 106  
Email:  service@bartco.com.au    Page 30 of 52 

VMS WEB STUDIO® User Manual v4.1.0 

On completion, the result will be displayed in the Information panel at the bottom of the 
page. 

 

Success:              Failed: 
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10. Radar 

Any Bartco VMS asset can become a speed advisory sign provided the asset is fitted with a Radar. 
 
The Radar can be programmed in two ways depending on the requirement: 

- Option 1: Display the detected speed only 
The asset typically stays in off mode and starts displaying the speed of the vehicle upon 
detection then go to sleep again. On top of detecting the speed of the approaching 
vehicle, the user can also set up an advisory message if the road user is going above the 
specified speed limit or below the speed limit. 
 

- Option 2: Interrupt displayed message 
Instead of going to sleep/off the asset can show a standard message or speed limit 
message when no vehicle is present. In this instance, the standard message needs to be 
uploaded to the asset separately to the radar file. 

 
The Radar feature is accessible under the “Tools” menu: 

 
 

Radar feature will be displayed as follows: 

 
 

 

Setup radar logs to 
be emailed daily 

Download radar 
logs manually 

Disable radar 
on asset 

Upload radar 
config to asset 

Option 1 

Option 2 
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Two actions can be executed on the asset after the radar detects approaching vehicle. 
 
The first action on the asset can be set to any of the following: 

 
 

i. Speed 
Asset shows the detected vehicle speed only, it can be shown in 2 different formats. 
Example: speed can be shown as 70 km/h or just 70 (tick Large checkbox for this) 

 
ii. Radar High/Low 

In this option the user can upload 2 files (Such as “TOO FAST” for speeding and THANK YOU 
for doing below the speed limit) that can advise the speeding vehicle that they are doing 
over the speed limit or doing below the speed limit without showing the vehicle speed.  

 
iii. Radar High 

In this option the user can only upload 1 file that can advise the speeding vehicle if the 
vehicle is approaching above the speed limit to say SLOW DOWN or TOO FAST. If the vehicle 
is doing below the speed limit, then the asset will not respond to them. 

 
iv. Radar Low 

In this option the user can only upload 1 file that can advise the speeding vehicle if the 
vehicle is approaching below the speed limit to say THANK YOU. If the vehicle is doing above 
the speed limit, then the asset will not respond to them. 

 
The second action on the asset can be set as follows: 
 
If the first action of the asset is to show the vehicle speed and follow it up with advisory message, 
then the user needs to select SPEED option in the first option and RADAR HIGH/LOW in second 
option. 
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Note: The files such as TOO FAST, SLOW DOWN or THANK YOU needs to be prepared first as 
described in section 7. Create Message and save the files as described in section 8.1 Save File 
 
The so-called over speed and under speed threshold can be set up at the “Posted Speed Zone” 
Minimum and maximum detection speed limits can also be setup on the asset to prevent it to be 
abused. 
 
Note: the asset will not respond if the detected speed of the approaching vehicle is outside of the 
minimum and maximum detection range. However, the logs will record the speed of every vehicle. 
 

 
 

The user can also schedule a radar that can turn on/off at certain times of the day. Radar default file 
can be used if a message needs to be displayed on the asset during the scheduled radar times.  
 
Note: Radar default file will only work if the radar file is scheduled. For example, see section 12.2 
Schedule a radar file. 
 
 

 
 

 

Enable data logging to record detected speed of the vehicle with a timestamp. Radar logs can be 
downloaded manually or set up to be emailed daily. 
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➢ Upload radar to asset 

i. Save file if required for later use as described in section 8.1 Save File 
Note: Radar files are saved as different file types than standard files. You may wish to have a 
separate folder for your radar config. 
 

ii. Select asset(s) in Assets list 
 

iii. Click on Upload button  at bottom of the Radar tab 
Radar config that is open in the Radar tab will be uploaded to the selected asset. 

 
iv. The user will be prompted as follows: 

 
 

v. Click on YES to upload file to the selected asset(s). The job will appear in Job Queue. 
Click on NO to cancel uploading. 

 
 
On completion, the result will be displayed in the Information panel at the bottom of the 
page. 

 
Success:        Failed: 
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11. SMS & Security 

Your asset is equipped with security and operational features which means the asset can send an 
SMS to the operator/s if the unit is tampered with, stolen or if there are any voltage issues. 
 

From the Tools menu select SMS: 

 
 

 

The following SMS options can be set: 
 
 
 
 

 
 

 
 
 

Various 
alarms to be 
set on asset 

Set mobile numbers 
to which SMS is 

sent by asset 

Reporting 
interval for 

alarms 

Upload SMS 
config file to 

asset 
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Select your options as required, following are suggested settings: 
- Over voltage: recommended at 14.5 V 
- Under voltage: recommended at 11.0 V 
- Over Temperature: usually not required 
- GPS movement: recommended at 1000 m  

Note: Ensure that you either upload this option after the asset has been deployed to its 
desired location or the asset is set to sleep prior to moving. 

- Tamper Enabled: Anti tamper wire where it is fitted 
 
After your options are selected, input up to 3 mobile phone numbers that will be alerted if any of the 
alerts are activated. 

 
 
To remove SMS settings simply uncheck all the boxes and upload file to the asset.  
 
We suggest saving your active and inactive SMS settings in separate folders for consistency and 
future use. 
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➢ Upload SMS config to asset 

i. Save file if required for later use as described in section 8.1 Save File 
Note: SMS files are saved as different file types than standard files. You may wish to have a 
separate folder for your SMS config. 
 

ii. Select asset(s) in Assets list 
 

iii. Click on Upload button  at bottom of the SMS & Security tab 
SMS config that is open in the SMS & Security tab will be uploaded to the selected asset. 

 
iv. The user will be prompted as follows: 

 
 

v. Click on YES to upload file to the selected asset(s). The job will appear in Job Queue. 
Click on NO to cancel uploading. 

 
 
 

On completion, the result will be displayed in the Information panel at the bottom of the 
page. 

 
Success:        Failed:     
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12. Scheduler 

Your VMS comes standard with a GPS module which allows the VMS to keep time as well as the 
ability to schedule messages as required, instead of uploading messages each time. 
 
Perfect for Roadworks applications where there may be a pre-warning message, and a message to 
be displayed once the Roadworks begin. 
 
 

12.1 Create Schedule 

To Schedule a file, the desired messages need to be created first as described in section 7. Create 
Message and save those messages as described in section 8.1 Save Message 
 
The Scheduler feature is accessible under the “Tools” menu: 

 
 

Scheduler feature will be displayed as follows: 
 

 

 

 

 

 
 

 

 

 

 

 

 
 

Default file: the default file is displayed when the other scheduled messages are not operating. If no 
default message is selected, then the asset will be blanked when the other scheduled messages are 
not operating. 
 
 

 
 

 

Default file: this message is 
displayed when other scheduled 

messages are not operating 

List of 
scheduled 
messages 

Prepare 
message to 

be scheduled 

Upload schedule 
to asset 
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➢ Select a default file: 
 

i. Click on Default File button 
 

ii. Select a file from File Dialog and click Open 

 
 

 

iii. Default file will be selected, and its preview displayed as below: 
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➢ Schedule a message: 

i. Click on “Add Message” button 
 

 
 
 
 
 
 
 

ii. Click on “Select File” button 
 

iii. Select a file from File Dialog and click Open 

 

Reset: reset all 
values to 
default 

Close: close this 
configuration 

section 

Insert: 
schedule a 

file 
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iv. A file will be selected, and its preview displayed as below. 
Other options will now be enabled 

 
 

v. Set date and time for the selected message to run as part of schedule 

 
 

vi. Click on “Insert” button to add this message to the list 

 
 
The message R-ahead will now run from 01/12/2021 to 10/12/2021 from 9am to 6pm every day. 
Outside these times, the default message will be displayed. 
 

Note: If the Continuous box is checked then the message will run from 9am on 01/12/2021 until 6pm 
on 10/12/2021 as a continuously running message. 
 

If you would like any other messages to be scheduled simply repeat the process above. 
 
 
 
 
 

Click on the calendar 
and clock icons to 

change select date and 
time 
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➢ Upload schedule to asset 

i. Save file if required for later use as described in section 8.1 Save File 
Note: Scheduled files are saved as different file types than standard files. You may wish to 
have a separate folder for your schedules. 
 

ii. Select asset(s) in Assets list 
 

iii. Click on Upload button  at bottom of the Scheduler tab 
Schedule that is open in the Scheduler tab will be uploaded to the selected asset. 

 
iv. The user will be prompted as follows: 

 
 

v. Click on YES to upload file to the selected asset(s). The job will appear in Job Queue. 
Click on NO to cancel uploading. 
 

 
 

On completion, the result will be displayed in the Information panel at the bottom of the 
page. 
 
Success:            Failed: 
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12.2 Schedule a radar file 

Example of scheduling a radar file: 
 
A VMS asset is placed in school zone that normally shows the speed limit 60 and changes the speed 
limit to 40 between 8:00am to 9:30am with radar that shows “SLOW DOWN” if the vehicle goes over 
the speed limit of 40. 
 
In this case the radar file will be created with the following: 

 
   
Once the radar file is ready then the schedule will be prepared with the current radar file between 
8:00am to 9:30am with a default file that shows the speed limit 60. 
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13. File Manager and Uploading Multiple Files 

Multiple messages or options to your asset can be uploaded directly from File Manager 
 

 
 

 

 

File Manager displays list of files and folders. 
 

 

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 

Rename selected 
file or folder 

Delete selected 
file or folder 

File’s 
details 

Rename: rename 
file or folder 

Delete: delete file or 
folder 

Create New 
Folder 

Open file or 
folder 

Upload multiple 
files 

v v 
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➢ To upload file(s) from File Manager: 

i. Click on Upload Files 
The following dialog will be displayed: 

 
 

ii. Click on Add File and select type of file (Standard, Radar, etc.) or function (Blank sign, etc.) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

v 
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iii. For type of file, select file(s) from file dialog 
Select a file and click on “Select File” button 

 
 

iv. Once all the files have been listed, select asset(s) in Assets list and click on “Upload” button 

 
 

v. The user will be prompted as follows: 

 
 

 

v 

v 
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vi. Click on YES to upload files to the selected asset(s). The job will appear in Job Queue. 
Click on NO to cancel uploading. 

 
 

 
 

On completion, the result will be displayed in the Information panel at the bottom of the 
page. 

 
Success:              Failed: 
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14. Hire Management 

A significant feature of Bartco’s Web Studio is for hire companies or other general users to be able to 
provide their own customer or user with a login and access to asset(s). 
 
Customers can be given access to the system for a determined period, relative to their hire period. 
Once the customer has finished their hire, they do not have access to the asset again. The hire user 
uses their username and password to login to Web Studio. 
 
The Hire Management feature is accessible under the “Tools” menu: 

 
 

 

 

Hire Management feature will be displayed as follows: 
 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

  

Customers: create, 
edit, and delete 
hire customers 

Assets: assign or 
unassign assets that 
hire users can access 

Notes: add notes for 
hire customer that 

is only visible to you 

Users: hire users 
that can access 
assigned assets 
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14.1 Add Hire Customer 

i. Select Add Customer   

 
 

ii. Add details of the hire customer and the duration of their hire/use 

 
 

iii. Click OK 
 

iv. Hire customer will be added in the list 
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14.2 Add User(s) to Hire Customer 

After the hire customer has been added, create new user(s) to the hire customer. 
Note: For security purposes it is a good idea for each user to have their own username and 
password. 
A temporary password will be automatically generated and emailed to the hire user. 
 

 
 
 
The hire users can then be managed in Users list: 
 
 
 
 
 

 
 
 
 
 

Edit details or 
permissions of 

selected hire user 

Delete 
selected hire 

user 

Unlock hire 
user’s 

account 

Request reset 
password on hire 

user’s account 
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14.3 Add Asset(s) to Hire Customer 

Assign the asset(s) that the users of the hire customer will get access to: 
 

 
 

Note: Multiple assets can be assigned to Hire customer. 
 

 
The hire user can then be given the newly created username and password and be advised to change 
their password on their first login. They will be responsible for what is displayed on the asset under 
their login. 
 
When the asset on hire, it will be displayed on the Asset’s status icons: 
 

 
 

 

 Asset is currently on hire to HIRE-CUSTOMER-NAME 

 Asset is hired to HIRE-CUSTOMER-NAME and hire duration is inactive 

 Asset is available to hire 

 No permission to hire asset 
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15. Troubleshooting 

When the asset doesn’t communicate on Web Studio with the following error: 

      
 

POSSIBLE CAUSE POSSIBLE SOLUTION 

Asset out of mobile phone coverage  Move asset to better coverage 

Sim card not inserted properly  Check sim card orientation 
(Reset power after re-positioning sim) 

Modem Failure  Contact Bartco 

Electrical Check fuses and battery level 

 
Please contact Bartco’s technical support on 1300 306 106 or service@bartco.com.au for any 
technical assistance. 
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